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1 Introduction 

This integration guide details the processes required to integrate the Apteco Marketing 

Suite with the CleverReach® email service provider (ESP). 

Integration options: 

FastStats 
For a one-off broadcast, you can use a combination of the Email Broadcasting and Email 

Responses wizards to upload your list, schedule a broadcast campaign, and finally 

receive responses from your customers into your FastStats system for further analysis. 

PeopleStage 
Automate data uploads for unattended and scheduled marketing broadcasts, 

PeopleStage allows you to define and implement marketing process flow diagrams that 

react to the responses you receive from the ESP. 

Export and Upload a File 
Access generic FTP support to allow data export and upload to third-party digital 

broadcast providers. 

Note: 

Apteco approves this integration with CleverReach®.  Use of the Apteco Marketing 

Suite in combination with CleverReach® software through this integration does not 

affect the intellectual property rights indemnity provided in the Apteco Marketing 

Suite “End User Licence Agreement”. 

 Summary of CleverReach® functionality 
Technology 
CleverReach® integrates with your FastStats system by utilising a RESTful transport over 

HTTP/S, in conjunction with SFTP. 

Supported Integrations 
CleverReach® supports all the above integration options. 

Type of Integration – User Defined 
CleverReach® is a User Defined integration meaning you can select variables at run time 

and create a personalised output based on specific requirements. 
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 Before You Begin 
CAUTION 

This guide assumes you have the relevant Apteco Marketing Suite system 

administration experience to perform this task, particularly with the FastStats 

Administrator, SQL Server and the areas of the Apteco Marketing Suite that relate to 

creating selections and campaign creation. If you do not, contact your Apteco partner 

or the Apteco support team. You need to have the appropriate system and SQL Server 

administrator permissions to install the relevant components successfully. Additionally, 

you will need to have Access to the broadcaster web-based control panel and obtain 

all the relevant information from CleverReach®. You will also need to understand how 

to construct your message in CleverReach®. 

This guide details the steps required to integrate FastStats and PeopleStage with a 

Broadcaster using an API; the document is in two parts: 

•  The configuration of the Apteco Marketing Suite 

•  Appendices which include: 

a. A summary of configuration in CleverReach® 

b. API Parameters 

You need to configure CleverReach® before you perform all the steps in Chapter 4 

• Make a note of your Message and List names that you create in CleverReach 

• Confirm the CleverReach URN and Email Address field names, these can be 

found in the Placeholder column in the List field dialogue 

• Make a note of the parameter name/s in curly brackets used for personalisation 

in the message. 

for example {Firstname} etc. (You must set the upload template settings to use 
matching settings, if your FastStats system variable names do not match you can use the 
Override column in the PeopleStage Additional Variables tab) 

Useful to have before you start: 

• Database Connection String made up of the database server Instance name 

and FastStats system name, for example: 

• <SQLServerInstanceName>;Initial Catalog=RS_<SystemName>;User 
Id=faststats_service;Password=fa5t5tat5; 

• The Digital Integration.zip available from: 

https://www.apteco.com/portal/software-releases 

• Decide where your FERG folders are to be created 

Used to store the .xml and .bat files used when scheduling FERG 

Note: Bulk insert folder must be accessible from SQL Server to use BULK INSERT 

• Decide where you want the FastStats Email Response Gatherer to be installed 

This will typically be on the same PC as the FERG folders but can be on any PC 

 

 

https://www.apteco.com/portal/software-releases
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Note:  
This guide follows the same structure as all our other integrations however you will need to 
perform step 4.2 first to obtain the Access Token as it is used in step 3.5 and 5.1 

• The CleverReach® Client Id, OAuth Client ID, OAuth Client Secret and 

Redirect Uri.  Access Token obtained in the FastStats Upload Template Edit 

Template form using parts 1,2, and 3 above.  (The Redirect Uri is a web page 

that is loaded after obtaining the Access Token e.g. https://www.domain.de). 

• The CleverReach® Web Client Username and Password 

• The CleverReach® API Username and Password 

• The CleverReach® List Name and Message Name that you have set up in the 

Web Client 

Note: 

The CleverReach® OAuth Client ID and OAuth Client Secret can be obtained from 

Apteco support in Germany support@apteco.de, please see the back of this document 

for contact details 
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2 Process Summary 

 Architecture 
The following diagrams describe a typical process from FastStats to CleverReach®, to 

the customer and back to FastStats. 

Schematic showing campaign scheduling performed in CleverReach®. 

 

1. A broadcast is initialised through the FastStats Web Service using the Email 

Broadcasting Wizard, which inserts a job into the Web Service Control database 

(WS_DB). 

2. The FastStats Service picks this job up, uploads the list to the CleverReach® SFTP site 

and then uses RESTful communication to monitor the upload. 

3. CleverReach® then imports the contents of this list to its subscribers and associates 

them with a list name ready for use in any email campaigns. 

4. A campaign can then be scheduled using the CleverReach® web interface. 

5. CleverReach® sends Messages to all recipients on the list. 

6. CleverReach® records any undelivered messages. 

7. CleverReach® records a response for each interaction with a message (for example 

opens and clicks). 

8. A scheduled job on the FastStats server initiates the FastStats Email Response 

Gatherer (FERG) which checks the SFTP site for response files. 

9. These responses are then imported into the Response database (RS_DB) ready for 

analysis by your FastStats system. 
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Schematic showing scheduling performed in FastStats or PeopleStage. 

 

The key difference in this process is messages are sent from CleverReach® automatically, 

allowing full control of the campaign scheduling from within the Apteco Marketing 

Suite.  

Note: 

For the message to send automatically, you need to create a Message in CleverReach®. 
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3 Apteco System Configuration 

 Creating the Response Database 
You will need to create a response database to receive your responses from the ESP.   

1. Open the FastStats Configurator. 

Tip: 

Search for Fast in the Start Menu  

 

2. Select Database Management. 

 

3. Select the Database Creation Wizard option and click Start Wizard. 
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4. Enter the name of the Database Server where you wish to store the response 

database, click Test Connection 

 

Note: 

The Database Server name can be found by launching SSMS and finding the SQL 

Instance for your FastStats system, for example TDWIN10B\SQLExpress.   

 

5. Enter a System name (for example Holidays) and your secure password.  
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6. Select the Email Response check box, then click Next. 

 

Note: 

The Response Database may already exist, see the Notes column if it does you do not 

need to complete this process, click X to exit the installer. 

7. Click Next on the Review actions step. 
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8. Click Run Scripts. 

 

9. Click Finish. 
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 Linking the Response Database to the FastStats 
Service 

You need link the response database to the FastStats service. 

1. Open the FastStats Configurator 

2. Select FastStats Services 

 

3. Select the FastStats Service for the system to link to the response database, click 

Properties 
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4. Select the system tab you want to link the response database, select Email 

Broadcasting from the list on the left and then enter the database connection 

string to your response database. 

 

5. Click Test Connection, click OK to close the dialogue box 

 

6. Select Save from the File menu 

Note: 

A restart of the FastStats service is required to pick up the changes to the 

configuration, click Restart in the Managed Services dialogue box. 

vary with your account: nr23.elaine-asp.de 

General Considerations 

For broadcasts to work correctly you need to ensure that the FastStats server has 

access to the relevant CleverReach® server through port 443, see the example URL 

below; this may 
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 Installing the Email Response Gatherer 
You can find the FastStats Email Response Gatherer installer in the 

DigitalIntegration.zip, extract the zip file to your designated PC where you want the 

email response web gatherer to run.  

Digital Integration.zip available from: 

https://www.apteco.com/portal/software-releases 

Note: 

The FastStats Email Response Gatherer application can run on any PC in your system. 

 Open the EmailResponseGatherer64Setup.msi from the DigitalIntegration\ 

EmailResponseGatherer folder. 

1. Click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.apteco.com/portal/software-releases
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2. Select the check box to accept the terms and click Next 

 

3. Click Change if you wish to install the Email Response Gatherer application in a 

different location then click Next 

 

Note: 

The default directory for this is C:\Program Files\Apteco\FastStats Email Response 

Gatherer x64 but may be different, we recommended that you install this in your 

FastStats application files directory on the FastStats Application Server. 
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4. Click Install to start the installation 

 

5. Once the installation has completed, click Finish 
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 Creating the Response Gatherer Folders 
You will need to create folders to store the files to use with the Response Gatherer; 

these will include the following types of files. 

Table 1 – Files Associated with the Response Gatherer 

Type of file Description 

Batch (.bat)  Contains the information for applications like 
Task Scheduler or command-line programs 
to run the Response Gatherer on a schedule 

XML (.xml) Contains the connection and 
communication parameters used to connect 
to the broadcaster 

Text files (.txt) The Response Gatherer will generate two log 
files each time it runs, an Event log with the 
times each event occurred, and a Details log 
with a step by step log of the digital response 
batch process with the broadcaster 

 

You can create the directories in any user-defined location and use your own choice of 

name; you must refer to the directories in the batch file. 

A typical example folder structure 

 

Important: 

The bulk insert directory must be accessible from the SQL server and the user running 

the SQL Server Service must have read permissions to it. 
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 Creating the Configuration File 
You will need to create an XML file containing the configuration settings to use with the 

Email Response Gatherer; the XML file is specified in an argument when you run the 

EmailResponseGatherer.exe 

Note: 

You can use the Response Gatherer with multiple integrations by using an XML and 

matching batch file for each integration. 

1. Browse to the directory where you installed the Email Response Gatherer and open 

the EmailResponseConfig.exe, enter your Connection String and click Test 

2. Select CleverReach® from the Broadcaster drop-down list 

3. Enter the Username and Password to use with the CleverReach® API 

4. Use Add to add all the required parameters for the Broadcaster 

5. Use the File menu to save the XML file to the batch and XML file folder 

 

Note: 

The Email Response Config application displays a warning message about required 

parameters until you have included them all.  
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Table 2 – Email Response Config Parameters 

Dialogue Item Settings to use 

Connection String (Required) The connection string to the response 
database for your system 

Timeout (secs) The timeout (in seconds) for the connection 
and query steps, the default is 1200 seconds 

Bulk insert folder (Required) The location to store the results to optimize 
the processing of campaigns that generate 
large volumes of data, SQL Server can BULK 
COLLECT from this location  

PeopleStage Connection String Used for certain broadcasters, to retrieve 
metadata from the PeopleStage database 

Not applicable with CleverReach® 

Username Note: 

The username and Password are not 
required with this integration 

Password 

Email Response Config dialogue with REQUIRED FIELDS completed 
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Table 3 – Email Response Gatherer Parameters 

Parameter Required Default Description 

ACCESSTOKEN Y  The Access Token is required to access your 
CleverReach REST API v3. Use the Generate Token 
in FastStats Plugin Configurations Wizard 

URL Y https://rest.cleve
rreach.com/v3/ 

The CleverReach log in URL that you use to 
access your account. 

CLIENTID Y  Obtained from CleverReach when you sign up 

URNCOLUMNAME Y e.g Urn* or URN* This should refer to the custom attribute name in 
the CleverReach payload that holds the 
FastStats Urn.  This will only be available if it has 
been originally uploaded from FastStats.  The 
value will get inserted into the Urn field in the 
Response table.  

DATEOFFSET Y 0 Value in hours to offset any date values received.  
This allows you to write responses in your current 
time zone. 

 

Note: 

The CleverReach® OAuth Client ID and OAuth Client Secret can be obtained from 

Apteco support in Germany support@apteco.de, please see the back of this document 

for contact details 
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 Scheduling the Response Gatherer 
You need to set FERG to run on a scheduled basis, provide it with the broadcaster’s 

communication details (in a .xml configuration file) and the location to output the Log 

files; this example uses Windows Task Scheduler however you can use any similar 

application or create Command Line (.cmd) files manually.  

Creating the Batch Files 

The batch files provide the Response Gatherer with the Log file directory and the name 

of the XML file to use. 

Create or modify the batch file using Notepad++ or similar text editor, see appendix C 

for an example file, save the file to the batch and xml file directory. 

Using Task Scheduler 

Using the Windows Task Scheduler, you can create multiple Tasks to run the Response 

Gatherer on a timed basis. 

1. Open Windows Task Scheduler 

Tip 

Search for Task in the Start Menu 

 

The Windows Task Scheduler opens 

2. Select Create Basic Task 
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Tip: 

You can create folders to organise your tasks 

3. Create a Basic Task step 

a. Give your task a Name and Description 

 

4. Task Trigger step 

a. Select the Trigger interval 

 

b. Enter the Start Date and Time or relevant sub-step details 
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5. Action step 

a. Select Start a program and click Next 

 

6. Start a Program Step 

a. Click Browse then navigate to the folder containing your batch files, select 

the file to use and click Open 

b. Optional: Provide the name of the XML configuration file in the Add 

arguments box, click Next  

Note: The XML file is typically included in the batch file. 

 

7. Summary step – Click Finish 

 

 



CleverReach® Integration Guide Fast Stats Broadcasting & Responses 
August 2019  
 

 

24 

 

4 FastStats Broadcasting & Responses 

Notes: 

You must log in as an administrator to perform the following task. 

The Email Broadcasting Wizard is required for FastStats use only. 

 Enable Email Broadcasting 
You must enable the Email Broadcasting wizard plugin. 

1. Open the FastStats Configurator 

2. Select Web Service 

 

3. Click OK on the Web Service Chooser dialogue box 

 

4. Click Client Configuration 
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5. Select the Discoverer client associated with your system and click Edit 

 

6. On the Plugins tab ensure the Apteco.Discoverer.Plugins.EmailBroadcasting check 

box is selected then click OK 
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 Configuration in FastStats 
1. Open Apteco FastStats, select the Users explorer, right-click on the Global node 

then navigate to Modify > Plugin Configurations 

 

2. Expand the Wizard node then clear the Inherit check box for Email Broadcasting 

(User Defined Fields) and then click on the Edit button. 

 

Clear 
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3. Click Add to add a new template 

 

4. Enter a Name, select the appropriate Resolve Table from the drop-down and select 

CleverReach® from the Broadcaster drop-down. 

 

Note: 

Scroll to enter the Known Parameters information, * indicates a required parameter. 

Complete the template parameters form with the required settings for your 

CleverReach® account. 
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Table 4 – Edit Template Known Parameters Settings 

Parameter Settings to use 

Client ID (Reqd) CleverReach Client ID 

OAuth Client ID (Reqd) CleverReach OAuth Client ID 

OAuth Client Secret (Reqd) OAuth Client Secret 

Redirect Uri (Reqd) The Redirect Uri is a web page that is loaded 
after obtaining the Access Token in the form 
https://www.domain.de 

Access Token (Reqd) Enter the above parameters and click 
Generate Token, see 4.2.1 below. 

Uri https://rest.cleverreach.com/v3/* 

Use Dated List Selected (default) 

Dated List Format yyyyMMdd-HHmmss 

From Email Optional. Enter the from email address for your 
message, leave blank to use the from email address in 
the CleverReach Message template. 

From Name Optional. Enter the from name for your message, leave 
blank to use the from name in the CleverReach 
Message template. 

Upload Empty Lists Selected (default) 

Email Field Name Email * 

SMS Field Name (blank by default) * 

Urn Field Name The name used in CleverReach for the Urn 
e.g. URN* 

Subject Optional, either use the PeopleStage Content 
field to match the Subject parameter in 
CleverReach or you can add a parameter 
here which will populate the email subject 
line, for example {SUBJECT_LINE[std:Summer 
Saver Promotion]} 

Mailing Draft Limit 10 (by default) * 

Message Retrieval Period 1M (by default) * 

Message Send Retries 10 (by default) * 

Encoding Default 

Note:  

*These settings will be specific to your CleverReach® account. 

Note: 

The CleverReach® OAuth Client ID and OAuth Client Secret can be obtained from 

Apteco support in Germany support@apteco.de, please see the back of this document 

for contact details 

https://rest.cleverreach.com/v3/
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4.2.1 Obtaining your CleverReach Access Token 

1. Enter the Client ID, OAuth Client ID and OAuth Client Secret 

 

2. Click Generate Token 

The following dialogue opens 
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3. Login to your existing CleverReach account to obtain the OAuth Access Token 

 

4. Enter your CleverReach Customer ID (the CleverReach Client ID), API Username 

and Password, click the Log in now… button 

The Uri Redirect page loads briefly, the Access Token box is now populated 

Note: 

You only need to perform this once so you can save the Access Token to use in the 

Response Gatherer and the PeopleStage Channel Editor 

 

Note:  

You will need to exit out of FastStats and log in again for these changes to take effect. 
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 Checking your configuration 
You can test the configuration by creating a Data Grid and using the email Broadcast 

Wizard; this will send a message to the people in your selection. 

Note:  

You must set up a message in CleverReach® before performing this step see Appendix 

A Configuring CleverReach®. 

1. Create a Data Grid based on the appropriate selection criteria and drag on the 

variables that you want to pass to CleverReach® (one must be an email address) 

 

2. Click the Email Broadcasting icon 

 

The Email Broadcasting Wizard opens 
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3. Choose the CleverReach® template from the drop-down list and click Next 

Note: 

The wizard will omit this step if you have only one Upload Template 

 

4. Choose the email field and click Next 

 

5. Review the additional fields that will be sent as part of the list and click Next 
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6. Complete the Email Broadcasting Details form then click Next 

 

Table 5– EmailResponseGatherer.exe.config Settings 

Option Settings to use 

Username  The username for your CleverReach® account 

Password The password for your CleverReach® account 

List Name drop-down Click on the List Name retrieve button and select a 
list from the drop-down (this appends any new 
records to the list) or enter a new List Name 

Message Name Click on the Message Name retrieve button and 
select one from the drop-down or leave it blank if 
you only want to upload your list 

A copy of the list will be 
saved to the directory 
below 

Browse to the location where you wish to save a 
copy of the list 

Email Address Enter an Email Address FastStats will use this to 
notify you once the list has been processed and 
then click Next 
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7. If you entered a message name, a Broadcast Warning message displays meaning 

this will send a message to your target audience 

Click Yes to commit this action 

 

8. Once the list has been uploaded (and if applicable the message delivery has 

been scheduled), the wizard will complete.  Click Finish to close the wizard. 

 

 

Note:  

You will need to exit out of FastStats and log in again for these changes to take effect. 
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 Email Responses Wizard 
When your emails have been sent out you can start analysing the responses from your 

target audience. 

1. Open the Email Responses wizard 

2. Enter the name of the message that you used in the Email Broadcasting wizard 

and click Next 

 

3. As the Email Response Gatherer starts collecting information from 

CleverReach®, you will see how customers are interacting with your broadcast. 

If you want to analyse this information further, click on Create a virtual variable 

from this information and then click Next 
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4. Drag the Email variable that you used in the Email Broadcasting wizard onto 

the drop box and click Next 

 

 

5. Locate the folder where you wish to store the virtual variable and click Next 
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6. Enter any notes that will be stored along with the virtual variable and click Next 

 

7. Enter a Description for the virtual variable or drag an existing virtual variable 

onto the drop box if you wish to overwrite it. Modify the Security Attributes if 

applicable and then click Next 
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8. Click OK 

 

9. Click Finish 
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5 PeopleStage Broadcasting & Responses 

 Defining the Broadcast Channel in PeopleStage 
To use CleverReach® with PeopleStage, you must set up a channel that defines the 

settings and parameters and any fields that you always want to send to CleverReach®. 

1. Open PeopleStage, select File > Administration > Channel Editor.  Click Add 

Email Channel through the context menu within a folder 

 

2. Enter a name in Channel Name 

 

Note: 

(Optional) Select Yes from the Allow In Transactional Output (you need to be careful 

if you select this option, as it means we can send multiple emails to the same email 

address) 
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3. Define Output Settings for CleverReach® 

 

Table 6 –PeopleStage Output Settings 

Field Settings 

Broadcaster Select CleverReach® from the drop-down 

Username Enter your API username 

Password Enter your API password 

Variable Name Select Email Address from the drop-down 

Variable Description Override Enter the description, for example, “Email Address” 
Note: This must correspond to the e-mail field within CleverReach® 

Upload but don’t broadcast (Optional) – Select this check box to upload the list only without 
initiating a broadcast 

Reply email Address The email address that will receive notifications when the channel 
is used, i.e. list uploaded / broadcast. 
Note: This is not the reply email address that will be used for the 
email send. 

Number of Retries The number of times to retry on failure of the channel.  It is 
recommended (for Broadcast Channels) to leave this at 0.  The 
Delivery Agent also has a retry value, so setting this to > 0 can result 
in multiple retries and may cause undesirable results 

Response File Key Type The key field to match responses to sends.  Varies from broadcaster 
to broadcaster due to the fields they return in the response file.  
Should be set to Communication Key for CleverReach®. 

Message Content Type Only Dynmark has the ability to use PeopleStage templates so this 
will always be Broadcaster Template.  This is where the creative 
comes from. 
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4. Complete the File Settings 

 

Note: 

The default Encoding is Windows-1252 if you change use the same setting on the 

Parameter Settings tab 
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5. The ESP Parameter Settings tab is blank by default, select parameters from the 

drop-down and click Add to complete the form 

 

Table 7 –Example PeopleStage Parameter Settings 

Field Settings 

 *Example, these will be specific to your account 

Client ID* CleverReach Client ID* 

Access Token* Paste the Access Token available from the Plugin Configurations Edit 
Template, see section 4.2.1 

Uri https://rest.cleverreach.com/v3/* 

Subject Optional, either use the PeopleStage Content field to match the 
Subject parameter in CleverReach or you can add a parameter here 
which will populate the email subject line, for example 
{SUBJECT_LINE[std:Summer Saver Promotion]} 

Message Retrieval Period 24M 

Encoding UTF8 

Urn Field Name The CleverReach Urn fieldname* 

See Appendix B for all the available parameters 

 

Note: 

The CleverReach® OAuth Client ID and OAuth Client Secret can be obtained from 

Apteco support in Germany support@apteco.de, please see the back of this document 

for contact details 

 

https://rest.cleverreach.com/v3/
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6. Add any additional variables on the Additional Variables tab 

 

Note: 

Use the variable description column to override and match the Variable Name to the 

name used for that parameter in CleverReach. 

7. Click Save & Close 
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 Broadcasting in PeopleStage 
You can now test your channel at any Delivery Stage 

1. You can drag your new CleverReach® channel from the Library to your Delivery 

step 

 

2. You can select from the available messages in CleverReach® from the Message 

Name drop-down or use PeopleStage’s functionality to dynamically select a 

message, to use a different language for example. 

 

 

3. You can use the same List Name as the Message Name or define a custom one 

Selecting the Requires Manual Approval check box gives the option to view a sample 

list before processing 
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Appendix A: CleverReach® Configuration 

FastStats or PeopleStage uploads a list of subscribers and insert them into the 

CleverReach® List 

If you wish to automatically broadcast the list to a message either from the 

Email Broadcast wizard or PeopleStage, you need to create a message within 

CleverReach®. 

Note: 

This section is not a detailed guide on using CleverReach, your Client ID and other 

credentials are provided by CleverReach during the signup process, for more 

information on using CleverReach please visit https://support.cleverreach.de 

1.  Login to your CleverReach® account to access the web-based control panel 

using the account specific URL provided by CleverReach® 
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2. The CleverReach dashboard opens 

 

Creating a new Message in CleverReach® 

If this is the first using CleverReach, you must create a List and an Email (Message),  

Note: 

The first time you use ClevrerReach®, you must create the fields to use in FastStats or 

PeopleStage. 

If these are already set up, you can select which Message and List to broadcast to 

and check the field names and parameters to use in FastStats or PeopleStage. 

• From Recipients either use an existing List or click Add List you do not need to 

add subscribers as FastStats or PeopleStage uploads a list of subscribers. 

You need to create a Message to use in FastStats or PeopleStage. 

• Step through the wizard to create a basic email and assign it to a List 

Note: 

You should test your message to ensure there are no problems with the email 

message. 
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Appendix B: API Parameters 

Table 8 – Email Response Gatherer Parameters 

Parameter Required Default Description 

ACCESSTOKEN Y  The Access Token is required to access your 
CleverReach REST API v3. Use the Generate Token 
in FastStats Plugin Configurations Wizard 

URL Y https://rest.cleve
rreach.com/v3/ 

The CleverReach log in URL that you use to 
access your account. 

CLIENTID Y  Obtained from CleverReach when you sign up 

URNCOLUMNAME Y e.g Urn* or URN* This should refer to the custom attribute name in 
the CleverReach payload that holds the 
FastStats Urn.  This will only be available if it has 
been originally uploaded from FastStats.  The 
value will get inserted into the Urn field in the 
Response table.  

DATEOFFSET Y 0 Value in hours to offset any date values received.  
This allows you to write responses in your current 
time zone. 
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Table 9. The following data is inserted into the FastStats Email Response Table 

 Required Response Table 

field 

CleverReach® extract file 

column 

EMAILCOLUMNNAME N Email Email address 

COMMUNICATIONKEYCOLUMNNAME N CommunicationK
ey 

FastStats Communication Key.  
Only be available if it has been 
previously uploaded from 
FastStats 

RUNCOLUMNNAME N  Reserved for future use 

TYPECOLUMNNAME N MessageType Response type 

MESSAGENAMECOLUMNNAME N  The message name is not 
returned in the CleverReach® 
extract file, but a reference is, 
this should typically be left as 
the default value 

DELIVERYDATECOLUMNNAME N DeliveryDate Delivery date 

CLICKURLCOLUMNNAME N ClickUrl The name of the URL that was 
clicked 

CLICKDATECOLUMNNAME N ClickDate Date the link was clicked 

EVENTTRIGGEREDDATECOLUMNNAM
E 

N EventTriggeredDa
te 

Date the response occurred 

ADDITIONALFIELDS N  Allows you to specify a pipe (|) 
delimited list of the additional 
fields you wish to include in the 
Response Details table.  This only 
acts as a filter, i.e. you can only 
specify fields that are included 
in the extract file. 

CONSTANTFIELDS N  Pipe delimited field of key value 
constants, seperated by # e.g. 
Key1#Value1|Key2#Value2. 

DATEFORMAT N UnixTimeStamp Date format used e.g. 
dd.MM.yyyy HH:mm 

EXECUTIONBUFFER N 0 Adds a buffer in minutes to the 
start of the response window.  
Use this to create an overlap to 
allow for delayed response 
notifications. 

EXECUTIONTAG N  When using Smart Execution, this 
can be used to identify seperate 
accounts when using the same 
broadcaster. 

LOOKUPBROADCASTIDSONTHEFLY N false False will force the Email 
Response Gatherer to download 
a full list of Broadcast Ids from all 
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the previous broadcasts in the 
response database.  This can 
then be used to quickly match 

MESSAGEENDDATE N  A specific date and time to when 
you wish to retrieve message 
names for the lookup in the 
format you specify (using yyyy-
MM-dd HH:mm:ss). 

MESSAGEPERIOD N 1M If MESSAGESTARTDATE or 
MESSAGEENDDATE are not used, 
this can be used to specify a 
period in days (D) or months (M) 
from the current date to retrieve 
message names for the lookup. 

MESSAGESTARTDATE N  A specific date and time from 
when you wish to retrieve 
message names for the lookup 
in the format you specify (using 
yyyy-MM-dd HH:mm:ss). 

ONLYPROCESSRECORDSWITHBROAD
CASTID 

N false Setting this to true will force the 
Email Response Gatherer to only 
download responses to 
messages that have originated 
from FastStats.  The default 
option is false; all responses will 
be downloaded. 

RECEIVERPAGESIZE N 5000 The page size of receiver’s data 
to return when calling apis GET 
/v2/reports.json/{id}/receivers 
and GET 
/v2/groups.json/{group_id}/recei
vers. Maximum 5000. 

REMOVEFILES N true  

REPORTSPAGESIZE N 100 The page size of reports data to 
return when calling api GET 
/v2/reports.json. Maximum 100. 

RESPONSEENDDATE N  A specific date and time to when 
you wish to retrieve responses to 
in the format you specify (using 
DATEFORMAT). 

RESPONSEPERIOD N 7D If RESPONSESTARTDATE or 
RESPONSEENDDATE are not used, 
this can be used to specify a 
period in days (D) or months (M) 
from the current date. 

RESPONSESTARTDATE N  A specific date and time from 
when you wish to retrieve 
responses from in the format 
you specify (using DATEFORMAT). 
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Table 10 – Email Broadcasting Parameters 

Parameter Required 

Y/N 

Default Description 

Client ID Y . CleverReach Client ID 

OAuth Client ID Y  CleverReach OAuth Client ID 

OAuth Client Secret Y  OAuth Client Secret 

Redirect Uri Y  The Redirect Uri is a web page that is loaded 
after obtaining the Access Token in the form 
https://www.domain.de 

Access Token Y  Enter the above parameters and click 
Generate Token, see 4.2.1 

Uri   https://rest.cleverreach.com/v3/* 

UseDatedList N true Setting this to false will remove the date and 
time stamp at the end of the file name 

DatedListFormat N yyyMMdd-
HHmmss 

 

From Email N  Optional. Enter the from email address for your message, 
leave blank to use the from email address in the 
CleverReach Message template. 

From Name N  Optional. Enter the from name for your message, leave 
blank to use the from name in the CleverReach Message 
template. 

UploadEmptyLists N true Set this to false if you wish to prevent empty list 
being uploaded to CleverReach® 

Email Field Name N  Email * 

SMSFieldName   The name of the field in CleverReach® that will 
hold the mobile number 

UrnFieldName N  The name of the field in CleverReach® that will 
hold the URN 

Subject N  Optional, either use the PeopleStage Content 
field to match the Subject parameter in 
CleverReach or you can add a parameter here 
which will populate the email subject line, for 
example {SUBJECT_LINE[std:Summer Saver 
Promotion]} 

Mailing Draft Limit N 10  

Message Retrieval 
Period 

N 1M  

Message Send Retries  10  

Encoding N UTF8 Enter the encoding of the incoming file 

 

 

 

https://rest.cleverreach.com/v3/
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Note: 

The CleverReach® OAuth Client ID and OAuth Client Secret can be obtained from 

Apteco support in Germany support@apteco.de, please see the back of this document 

for contact details 
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Appendix C:Example Batch File 

Example batch file to use with FERG and scheduling 

@echo off 

REM**************************************************************************** 

REM File Name: CleverReach®BatchFile.bat  

REM Date: 30/01/2018 

REM ToDo: 

REM Define the drive and folders to output the log files 

REM Set FERG to define the location of the EmailResponseGatherer64.exe 

REM Set LOGFILE to the folder where the event logs are stored 

REM Set LOGFILEDETAILS to the folder where detail logs are stored 

REM Define the XML configuration file to use 

REM *************************************************************************** 

REM IMPORTANT Change the drive letter to match the drive you have created your FERG directory 

C: 

cd C:\FastStats\FERG 

cls 

SET FERG="%ProgramFiles%\Apteco\FastStats Email Response Gatherer x64\EmailResponseGatherer64.exe" 

SET LOGFILE="Logs\CleverReach.txt" 

SET LOGFILEDETAILS="Logs\ CleverReach _Details.txt" 

echo. >> %LOGFILE% 

echo. >> %LOGFILEDETAILS% 

echo %date% %time% - Starting FastStats CleverReach Response Download >> %LOGFILE% 

echo %date% %time% - Starting FastStats CleverReach Response Download >> %LOGFILEDETAILS% 

echo. >> %LOGFILE% 

>> %LOGFILEDETAILS% 

echo. 

%FERG% CleverReach.xml >> %LOGFILEDETAILS% 

 

IF ERRORLEVEL 9003 goto FailedException 

IF ERRORLEVEL 9002 goto FailedLogout 

IF ERRORLEVEL 9001 goto FailedDownload 

IF ERRORLEVEL 9000 goto FailedLogin 
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:OK 

echo %date% %time% - FastStats Gathered Elaine Responses OK >> %LOGFILE% 

goto Complete 

 

:FailedLogin 

echo %date% %time% - FastStats Gatherer Failed - Login Failed to Elaine >> %LOGFILE% 

goto Complete 

 

:FailedDownload 

echo %date% %time% - FastStats Gatherer Failed - Downloading from Elaine >> %LOGFILE% 

goto Complete 

 

:FailedLogout 

echo %date% %time% - FastStats Gatherer Failed - Logging out of Elaine >> %LOGFILE% 

goto Complete 

 

:FailedException 

echo %date% %time% - FastStats Gatherer Failed - Elaine API Exception >> %LOGFILE% 

goto Complete 

 

:Complete 

echo %date% %time% - Completed FastStats Elaine Response Download >> %LOGFILE% 

End of example text 

To see how to use the batch file see section 3.4 Scheduling the Response Gatherer 
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Appendix D:Troubleshooting 

The following are some common problems that may occur, and procedures for 

resolving them. 

Errors relating to configuring and using FERG 

These errors can occur due to missing files 

Description: Error received when running FERG using a batch file 

Error: Could not read email response configuration file: Could not 
find file 'D:\FastStats\FERG\Elaine.xml'. 

Elaine.xml refers to the filename referenced in this section of the batch file: 

%FERG% CleverReach.xml >> %LOGFILEDETAILS% 

In the location: 

“cd D:\FastStats\FERG” in the batch file  

Solution: Ensure the file exists or change the filename in the batch file to match. 

 

Errors relating to running a campaign 

These errors can occur due to  
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For customer service and technical support visit: 

www.apteco.com/support 

T: +44 (0)1926 407 595 (Support Desk) 

Note: If you have purchased the Apteco Marketing Suite™ via one of our partners 
then they are your first line of support. 

 

 

Apteco GmbH 
Kaiserstraße 35 
60329 Frankfurt am Main 
Germany 
T: +49 (0) 69 25 66 97 0 – 0 
support@apteco.de 
www.apteco.de 

 

  

Apteco Australia Pty Ltd 
Level 4 
55 Harrington Street 
The Rocks NSW 2000 
Australia 
T: +61 (0) 2 8355 2524 
www.apteco.com.au 

 

  

Apteco Benelux 
Stationsplein 45, Unit 4.004 
3013 AK, Rotterdam 
The Netherlands 
T:  +31 (0) 10 80 80 875 
Email: support@apteco.nl 
www.apteco.nl 

  

  

Head Office 
Apteco UK 

Tink-a-Tank House 
21 Jury Street 
Warwick 
CV34 4EH, UK 
  
T:  +44 (0) 1926 407565 
E:  support@apteco.com 
W: www.apteco.com 

© 2018 Apteco Ltd. All rights reserved. 

This publication is for informational purposes only. While every 
effort has been made to ensure accuracy, this publication shall not 
be read to include any warranty or guarantee, express or implied, 
including about the products or services described or their use or 
applicability.  

Apteco Ltd. reserves the right to modify or improve the designs or 
specifications of its solutions at any time without notice. 
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